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Chapter 1: Introduction  
  

  

Product Description  
  

Scribe is a professional caption editing and caption file creation tool that allows users to 

rapidly create timed caption files for locally stored media assets or proxy video files streamed 

via EEG’s Courier system. Scribe puts you in control of caption timing, placement, style, and 

more. For information regarding the integrated Scribe/Courier workflow please download 

documentation from our website:   

https://s3.amazonaws.com/eegent-assets/resources/Scribe_Courier_Workflow.pdf  
  

  
  

Licensing  
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Full License   The full Scribe license allows users to load locally stored video files into 

Scribe projects for caption creation.  

Cloud Only   Scribe’s “Cloud Only” license permits Scribe usage for proxy video files 

assigned and streamed via the Courier system only.  
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Chapter 2: Set Up  
  

System Requirements  
✓ Windows 7, Windows 8, Windows 10  

✓ 1GB RAM, 2GB or more recommended  

  

Installation  
A Windows installer file (.exe) will be provided after purchasing this software. Installation steps 

are as follows:  
  

1. Double click the installer file to begin installation. You should see the license 

agreement screen as shown in Figure 1.  
  

  
Figure 1: Installer Welcome Screen  

  

2. After reviewing the terms, check the “I agree” box and click Install to continue with 

installation.  
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3. After successful installation a completion window will be displayed.  
  

Chapter 3: Starting a New Project  
  

Create a project by clicking the New button located in the File toolbar at the top. You 

will be prompted to choose “Empty Project” or “Custom” project. “Custom” allows you 

to load a combination of any local video file, transcript, or caption file to begin your 

project. See Supported File Formats on page 28 for a full list of acceptable video and 

transcript file types.  In Figure 2 we are loading both a video AND transcript file to begin 

our Scribe project. Name your project, select your files, and click the Ok button to 

continue.  

  

  

 
  

Figure 2: New Project Window   
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Loading Files  
Depending on your project type and workflow there are several ways to start a Scribe project 

which are:  

1. Captioning a Video from Scratch – In this case, the user will load the video file alone 

and can begin caption creation.  As shown in Figure 3, the user can import the 

locally stored video utilizing the Load Video portion of the File tab or a Cloud based 

video file by using the Courier tab.  

 

  

2. Using a Transcript to Caption a Video – If you have both a video file and a plain text 

transcript, the user can upload the video file as well as the transcript using the Load 

Captions portion of the File tab as shown in Figure 4.  By loading a .txt file or pasting 

the text directly into the Text Bucket (See Figure 8), the user can then begin to 

create captions for the video file.  

  

 

Figure 4: Transcript File Section  

  

  

  

  

  

Figure 3: Load Video Section of File Tab  
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3. Cleaning Up / Repurposing Captions from Another Source – Caption files contain detailed 

information about timing, positioning, and styling of captions.  Imported using the Load 

Captions portion of the File Tab as displayed in Figure 5, Scribe will populate captions in the 

timeline with the proper formatting and timing as defined in the file.  

 

  

4. Generate Captions Using Speech Recognition –Lexi integration utilizes our cloud-based 

speech recognition service.  Users can use Lexi to get the raw ASR captions or can use the 

Lexi data to realign existing captions or generate captions from an untimed transcript shown 

in Figure 6.  

  

 

Figure 6: Lexi Speech Recognition  

  

  

  

  

  

  

  

  

  

  

  

Figure 5: Caption File Import   
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Chapter 4: Using Scribe  
Scribe has a user-friendly interface that provides maximum flexibility for editing captions. Broken down 

for you here are all the components you will become familiar with while utilizing the program’s features. 

Displayed in Figure 7 are the multiple windows in which you will be primarily working.  

  

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

              Figure 7:  Scribe Main Feature Diagram  

Text Bucket   

Caption List/Timeline View   

Player Window   
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Text Bucket  
To create captions from a transcript, paste or load text into the Scribe text bucket as shown 

in Figure 8. Click the + button to add text from the bucket to Caption List and Timeline. Use 

the dropdown options located at the bottom of the text bucket to specify the desired 

number of lines/characters per row for new captions being created from the transcript. The 

more lines and characters in each caption, the more action is potentially being covered on 

the screen. Using fewer caption rows will result in more rapid caption display transitions on 

screen to keep pace with the program audio. Depending on the project, find a balance 

between the two to ensure quality and readability. The example shown in  Figure 8 

demonstrates that each new caption created from the text bucket will equal 2 lines of text, 

32 characters long each.  Bear in mind that most standard caption decoders support a 

maximum of 32 characters per row.    
  

  
Figure 8:  Text Bucket  

  

  

NOTE: When adding captions from the Text Bucket, if the number of captions exceeds the 

duration of the video, an error will be displayed as shown in Figure 9.  This could be caused by 

the default selection of caption display time which may be longer than the intended caption 

display time or there may be an unintentional break in the timeline.  
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           Figure 9:  End Time Error Example  
  

Caption List  
The caption view window at the bottom of the interface can be toggled between the Caption List and 

the Timeline View by selecting the indicated tab.  The Caption List view shown in Figure 10 allows the 

user to easily locate where the caption text from the Text Bucket has been placed within the Timeline.  

  

  
Figure 10:  Caption List Viewer  

  

The Caption List contains all captions added via the Text Bucket.  Text Boxes are created containing the 

caption number out of total number of captions, caption start and end time along with caption style 

selection and which row the captions will be placed on screen, followed by the actual text of caption.  All 

this information can be edited directly in the Caption Box by double clicking location of alteration and 

keying in the information as shown in Figures 11 & 12.  
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Figure 11:  Text Box  

  

  

   Figure 12: Text Box Edit Example  

  

  

  

Timeline View  
Once captions have been added in the Caption List, the caption text as well as start and end times are all 

reflected in the Timeline View as shown in Figure 13.  

  

  
Figure 13: Timeline View  
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With the captions placed in the Timeline, the user can now click to use the optional audio waveform and 

shot detection features to qualify the correct caption appear time.  Figures 14 through 16 show the 

steps to active these features.  

 

  

 

  

  

  

  

  

Figure 14: Click to Generate Audio Waveform  

  

  

Figure 15: Click to Generate Shot Detection  
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Figure 16: Audio Waveform & Shot Detection Active  

  

The Audio Waveform displays the waveform from the audio track contained in the video file, while the 

Shot Detection is broken up into each cut in footage.  If the footage has one continuous shot, Scribe will 

leave gaps between the footage while the quicker cuts and transitions are next to one another.  The first 

frame of each shot is displayed.  

  

  

  

NOTE: The Shot and Audio Waveform detection function may take some time as shown in the loading 

progress indicator at the bottom of the interface shown in Figure 17.  

 

  

  

  

Within the Timeline view there are two Zoom sliders as shown below in Figure 18.  The Zoom slider 

labeled A increases or decreases the time duration shown in the Timeline to compact or expand that 

  

Figure 17: Shot Detection Loading Sample  
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captions, audio waveform and shot detection for easy navigation.  The Zoom slider labeled B will 

increase and decrease the amplitude of the audio waveform to locate any unnecessary noise, peaking or 

to simply double check if the caption is appearing at the correct time with the subject’s speech.  

  

 
  

For quick and easy edit or removal of a selection of caption boxes, click and hold on mouse to drag the 

yellow dashed selection indicator over desired area along with the begin and end times of selected 

caption boxes.  The duration of the start and end will appear hovering above caption boxes which have 

been selected.  Caption boxes will appear with a yellow outline to ensure efficiency when selecting. (See 

Figure 19.)  

  

  
Figure 19: Selecting Caption Boxes  

  

  

Figure 18: Zoom Slider Location  

A   

B   
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Lexi™  
Our innovative Lexi feature provides speech recognition for raw ASR captions transcription. Post-ASR 

captions are appropriately placed into the Caption Timeline.  Lexi may also be used to realign existing 

captions or even generate captions from an untimed transcript for quicker turnarounds with little 

intervention from the user.  Below are the steps for activating and utilizing Lexi.  In this example, we will 

ask Lexi to generate captions for us.  

  

Lexi Sample  
To begin, load the video file you wish to caption located in the Load Video portion of the file tab.  Once 

the footage is imported into the Timeline, go to the Load Captions portion of the file tab displayed at the 

top of the interface. (See Figure 20).  Click on the Lexi ASR icon to proceed.  

 

                            Figure 20: Lexi Speech Recognition  

  

To activate Lexi, the user must sign in to their active EEG Cloud subscription.  For more details please 

visit eegcloud.tv. After signing in, the Speech Recognition Job window will appear. (See Figure 21).  

Located on the upper left side of the window, click Start New Job.  

  

  
Figure 21: Start New Job  
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The next window to appear (shown in Figure 22) will allow the user to select the  audio track to be used 

for the speech recognition job. Be sure to choose a track that contains dialog and click OK to continue.  

  

  
Figure 22: Audio Track Selection  

  

After the desired settings are selected, click the OK button to continue.  From there, Lexi will extract the 

audio then upload to the Speech Recognition Jobs window. (See Figure 23).  

  

  
Figure 23: Extraction of Audio  
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Once completed, click the Download Result button to proceed.  The next window allows the user to 

select the Lexi output function.  In Figure 24, we selected Generate Lexi Captions to generate the 

caption track, ignoring any captions that may have been entered in the Text Bucket. Appearance 

information for the generated captions should be selected in Output Style.  Click OK to continue.  

  
Figure 24: Output Type & Style Menu  

At this point, the captions will be generated and placed into the Timeline and Caption List.  You will 

receive an e-mail confirmation generated by your Cloud account when the speech recognition job has 

been completed.  All previous jobs are stored within the Speech Recognition Job window and can also 

be viewed in your Cloud account which is accessible from the Sign In window.  The Lexi-generated 

captions appear the same as an uploaded caption file or transcript file, as shown below in Figure 25.  

This applies whether Lexi is used for realignment or for raw ASR captions.  
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Figure 25: Lexi Job Complete  

Tabs  
Located at the top of the interface are the central tabs: File, Edit, Tools, Courier, and Help shown in 

Figure 26.  All tabs can be minimized by double-clicking on the header of the tab.  

  
Figure 26: The File Tab  

File   

Scribe Project   Import and save functions are located here as well as previously saved 

Scribe projects.  Click New to begin a new project or open a previous 

project by clicking the Load button.  

 Load Video    Here you can upload a local video or select a file from EEG Courier.  

Load Captions  Import a timed caption file into the Caption List (see page 28 for 

supported file formats), a transcript file into the Text Bucket or Lexi 

generated captions into the Caption List.  

Export Captions   Exports captions for repurposing or for reference.  

  

Edit  

  
Figure 27: The Edit Tab  

   

Add/Remove Captions    Edit captions within Caption List directly.  

 Edit Caption Time    Set start and end times for captions.  

Select Caption    Easy navigation through captions.  Go To allows users to search    

Scribe for specific caption using caption number.  

 Undo Redo        Undo or Redo unintentional actions.  
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Tools  

  
Figure 28: The Tools Tab  

   

Shift All Captions    When selecting Forward or Backward the Shift Captions window will be 

displayed. (See Figure 29 ).  The Start and End timecode values assigned 

to each caption within the selected range will be adjusted based on the 

shift value entered. Auto-Align Origin will reset captions to their original 

location.  

  

  
Figure 29: Shit All Captions Prompt Window  

    

Settings    Allow adjustments to basic settings such as Nudge value in frames and 

Fast Forward/Rewind rate.  User may also set backup storage and how 

often backups are saved.  Recommended to leave default setting of 

every 5 minutes.  

Project Info      Shows path and properties of saved project, video file and caption file.  
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Courier  
Courier is a Cloud-based job creation/management service allowing content creators to stream proxy 

video files to captioners who are using Scribe.  Courier can also be used to upload video files and 

schedule caption jobs for captioners using other NLE captioning software tools.  The Courier tab (Figure  

30) shows the tools required to interact with the service.  Please refer to eegent.com/courier for details.  

  
Figure 30: The Courier Tab  

Import cloud-based video files from the Load Video and export completed caption files back to the cloud 

from Export Captions.  

  

Project Configuration  

Playback Modes  
Playback modes menu located on right side of Media Player.  These widgets are collapsible by clicking 

the triangle indicator next to the widget label.  

  
            Figure 31: Playback Modes Menu  

  

Link Timeline  When the currently displayed frame of video changes (either due to a 

seek or because the video is playing), if the caption at the new timecode 

is different than the one that was previously being displayed, said new 

caption will automatically be selected. This is mainly useful in the list 

view so that the selected caption box is "linked" to the playhead 

position in the timeline.  
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Link Captions   The reverse of Link Timeline. When you select a different caption, the 

video auto-seeks to said caption's display time. Once again, this is 

mainly useful in the list view so that the playhead position is "linked" to 

the selected caption.  

Hold-Edit   Holds a selected caption in the Timeline and player for editing as the 

video continues to play.  This can be particularly helpful for time 

adjustments, allowing you to remain on the caption and wait for the 

new frame time you would like to change it to.  

Decode Captions   Can decode captions or disable decoding.  

  

Playback Speed  
When slowing down a video to a manageable speed, Scribe automatically pitch-corrects.  This means 

when reducing the speed of a video, the audio’s integrity remains fully intact for inserting accurately 

timed captions in a single pass-through.  

  
Figure 32: Playback Speed Menu  

   

Playback Speed   Increase or decrease speed of playback from Normal (100%) to 25%  

FF/RW Speed  Increasing or decreasing speed at which Scribe fast forwards and 

rewinds allowing editor to move swiftly to make necessary changes.   

Ranges from 2X to 20X.  

  

  

  

New Caption Template  
Permits changes to presentation of caption.  
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Figure 33: New Caption Template Menu  

  

Type    Change the style of caption.  Options are Roll-up 2 through 4, Pop-on and Paint 

on.  

 Row     Alteration of location of caption in video.  All rows available.  

Start  Select when this caption’s settings come into effect without having to navigate to location.  

 Display Time   Duration of caption display time on screen.  

   

Chapter 5: Tools  

Once a tool is selected, the cursor will turn into a line the color corresponding with the color of the tool 

selected, to ensure maximum precision as indicated by the orange in Figure 34.  

 

  

Timeline Tools  
The Timeline Tools are broken into three sections.  

  

  

  

Figure 34: Tool Color Example   
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Tool Menu  
Once the Drop-Down menu is opened, the user will view the window shown in Figure 36.  Once tool is 

selected, the icon of the tool icon will appear on the left side of the menu and highlighted in blue.  

  

  
Figure 36: Drop-Down Menu  

  

 Select      Basic cursor used for selection, drag and drop.  

Set Start/End Time  Start time is indicated by green line.  Place green line on new start time 

trimming or expanding caption.  Also applies for End time with red line 

as indicator.  

 Split    Separates one caption into two captions.  

  

Snap To  
The Snap To tools are used for realignment of caption boxes.  Same as the Tool menu, once selected the 

feature will appear on the left side of the menu and highlighted in blue. (See Figure 37).  

  

  

          

          Figure 35: Timeline Tools    

Drop - Down Tool Menu   Audio Waveform & Shot Detection   

Drop - Down Snap To Menu   
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              Figure 37: Snap To Menu  

Snap to Captions   Shifting a caption box over to align with the following or 

previous caption.  

Snap to Playhead   By lining up playhead to desired time, the caption box nearest 

playhead will snap to.  

Snap to Shot Changes   Quick precision by commanding caption to line up perfectly 

where the next shot change will begin.  

Audio Waveform and Shot Detection  
Located below in Figure 38, the icon labeled C is to toggle on and off the Audio Waveform in the 

Timeline while icon D toggles the Shot Detection.                       

 

Figure 38: Audio Waveform & Shot Detection Toggle  

  

  
D   C   
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Right-Click Menu  
When right-clicking on the Timeline, the window shown in Figure 39 below will appear.  These options 

allow for fast selection of multiple caption boxes and fast seeking to various times.  Broken down in the 

figure are the sections within the menu and their usage.  

  

E. Create New Caption  By placing the playhead at any location on the Timeline, you may insert a 

new caption into the indicated location or add a caption that will be 

aligned with nearby captions.  

F. Select All Captions  Executing the Select All function allows user to quickly select caption 

boxes before, after or at playhead’s video time.  

G. Go To  Navigates through the Timeline based on caption box or playhead 

location.  

H. Seek To  Right-clicking at a location on the Timeline users can use Seek to move 

playhead to selected time, or snap to before or after surrounding 

caption boxes.  

I  

  

    Figure 39: Right-Click Menu  

E   

F   

G   

H   

J   

K   
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I. Cut/Copy/Paste  Easy relocation of caption boxes by either cutting, copying, or pasting to 

new location.  

J. Loop Video  Loops interval of captions.  Use selection to indicate the beginning and 

end of interval before right-clicking and applying Loop. Indicated by dark 

green, click at beginning and end of interval to execute.  Dark green 

highlight will confirm the looped section.  

K. Begin  Alternative way to toggle on and off the Audio Waveform and Shot 

detection functions.  

  

Caption List Tools  
  

 
  

A. Paste     Paste  

B. Cut      Cut  

C. Copy     Copy  

D. Search    Find a word or phrase in text to locate the caption that needs editing.  

E. Replace     Locate word throughout project and replace all.  

F. Check Spelling   Check spelling within caption text.  

G. Italicize    Italicize font in caption.  

H. Underline     Underline font in caption.  

I. Highlight     Sets the caption text’s foreground color.  

J. Music Note    Add music note to indicate music is playing.  

K. Lines     Select which line your edits will apply to.  

L. Left Align     Assign text left side dominant.  

  

  

                   Figure 40: Caption List Tool   

C   A   

B   D   

E   

F   H   N   P   R   T   V   

G   
I   

J   K   
L   

M   O   
Q   S   U   W   
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M. Center Align   Assign text center dominance.  

N. Right Align    Assign text right side dominant.  

O. Nudge Left    Nudge caption row horizontal alignment left by 1 row.  

P. Nudge Right    Nudge caption row horizontal alignment right by 1 row.  

Q. Top Align     Vertical align of top caption with uppermost row available.  

R. Bottom Align  Vertical alignment of the caption rows with the bottom row.  

S. Nudge Up     Nudge caption row vertical alignment up by 1 row.  

T. Nudge Down   Nudge caption row vertical alignment down by 1 row.  

U. Set Start Time   Adjust selected captions start time.  

V. Set End Time   Adjust selected captions end time.  

W. Split     Split selected caption into two captions.  

  

Tool Tips  
When mouse is hovered over a tool, a Tool Tip will pop up explaining what that tools function is and its 

complementary short cut command.  In Figure 41, highlighted is an example of the mouse hovered over 

the Replace too followed by its listed shortcut. Tool Tips are helpful especially when first learning the 

software, allowing the user to quickly adapt and become acquainted the interface.  

  

 

Figure 41: Example of Tool Tip  

  

Chapter 6:  Exporting & File Formats  

Export Options  
  

As Caption File  Exports the resulting caption file you’ve created with Scribe, and saves 

it locally in your chosen format. See the Supported File Formats 

section for a list of all exported file types.  
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Send to Cloud  Exports the resulting caption file you’ve created and sends it to the 

Cloud (credentials required), back to the original content owner, as part 

of the Courier workflow.  
  
  

Supported File Formats  
  

Video File Input  MPEG-2/MPEG-4/H264 Transport Stream Files (.mpg, .m2v, .m2t, .ts)  

Material eXchange Format (.mxf)  

General eXchange Format (.gxf)  

Quicktime (.mov)  

MP4 (.mp4)  
  

Text File Input  

  

Plain Text File (.txt)  

Rich Text Format (.rtf)  

Microsoft Office 2007 (.docx)  

Microsoft Word 97-2003 (.doc)  

OpenDocument Format (.odt)  

Caption File Input  Basic Subtitle (.txt)  

Captions, Inc. (.cin)  

Cheetah 2.2 (.cap)  

Cheetah ASCII (.asc)  

CPC DOS (.cpc)  

CPC WIN CapMaker Plus (.cap)  

EEG Caption File (.ecf)  

EEG Simple or "Dot Number" Files (.0, .1, .2, ...)  

NCI (.ted, .cap, .flc)  

Scenarist (.scc)  

SoftNI (.sub)  

Softitler (.txt)  

Vitac VCAPS (.vcc, .vci, .vcp)  

WGBH - NCAM (.tds)  
  

 Caption File Output  EEG Caption File (*.ecf)  

Scenarist Closed Caption File (*.scc)  

SMPTE Timed Text File (*.xml)  

Simple Timed Text File (*.xml)  
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SubRip Text File (*srt)  

Synchronized Accessible Media Interchange / SAMI File (*smi)  
  

Chapter 7: Keyboard Shortcuts  

  

Function  Description  Shortcut  

Set Start Time (In 

Edit Tab)  
Set the selected caption’s start time to the current 

video time  
CTRL + [  

Set End Time (In 

Edit Tab)  
Set the selected caption’s end time to the current 

video time  
CTRL + ]  

Nudge Start Time Back  Nudge the start time backwards  CTRL + MINUS  

Nudge End Time Back  Nudge the end time backwards  CTRL + SHIFT + MINUS  

Nudge Start Time Forward  Nudge the start time forward  CTRL + PLUS  

Nudge End Time Forward  Nudge the end time forward  CTRL + SHIFT + PLUS  

New Caption  Create a new caption  CTRL + N  

Insert Caption  Create a new caption after the selected caption  CTRL + SHIFT + N  

Feed to New Caption  Send line feed from text bucket to new caption  CTRL + ALT + N  

Select Previous  Select the previous caption in the list  CTRL + ;  

Select Next  Select the next caption in the list  CTRL + “  

Toggle Play/Pause  Toggle the play state between play and paused  CTRL + P, Spacebar  

  

Find  Show find form  CTRL + F  

Replace  Show replace form  CTRL + H  

Save Project  Save project file  CTRL + S  

Nudge Up  Nudge selected row(s) up by 1  CTRL + ↑  

Nudge Down  Nudge selected row(s) down by 1  CTRL + ↓  

Un-feed Line  Move line(s) from selected caption back to text 

bucket  
CTRL + ALT + ↑  

Feed Line  Feed line(s) from text bucket to select caption  CTRL + ALT + ↓  

Left Align  Horizontally align caption row(s) left  CTRL + L  

Center Align  Horizontally align caption row(s) center  CTRL + E  

Right Align  Horizontally align caption row(s) right  CTRL + R  
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Nudge Left  Nudge selected row(s) left by 1  CTRL + <  

Nudge Right  Nudge selected row(s) right by 1  CTRL + >  

Music Note  Add music note to captions  CTRL + M  

Top Align  Vertically align captions to top  CTRL + T  

Bottom Align  Vertically align captions to bottom  CTRL + B  

Rewind  Rewind video  CTRL + ←, CTRL + J (Press 

once or hold)  

Fast Forward  Fast forward video  CTRL + →, CTRL + K (Press 

once or hold)  

Step Back  Step back 1 frame  CTRL + SHIFT + ←, CTRL 

+ SHIFT + J  

Step Forward  Step forward 1 frame  CTRL + SHIFT + →, CTRL 

+ SHIFT + K  

Jump Back  Jump back 5 seconds  CTRL + 9  

Jump Forward  Jump forward 5 seconds  CTRL + 0  

Underline  Underline selected caption text  CTRL + U  

Italic  Italicize selected caption text  CTRL + I  

Copy  Copy selected captions  CTRL + C  

Cut  Cut selected captions  CTRL + X  

Zoom  Zoom in and out of Timeline  CTRL + Mouse Wheel  

Highlight  Group selection of text boxes  SHIFT + 2  

Set Start Time  Trim or expand start time of text box  SHIFT + 3  

Set End Time  Trim or expand end time of text box  SHIFT + 4  

Split  Detach section of text box  SHIFT + 5  

Loop  Repeat selected interval  SHIFT + 6  
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